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1. Introducing Thuraya SatTrack

Thuraya SatTrack is a software-based tracking system designed for
Thuraya MarineStar. Thuraya SatTrack provides secure, private and
accurate vessel tracking to support operations, voyage planning
benefiting vessel owners and operators.

You, as a Thuraya Customer, can request Thuraya to provision a
Thuraya SatTrack package for the Marinestar terminals used by your
Company.

If this is the first time you are requesting a MSISDN setup for your
company, you will receive a license key. This license key can be used to
set up your account on the Thuraya SatTrack portal.

If you are an already existing user of the portal, you can login with your
credentials.

Thuraya SatTrack software can be accessed at
https://sattrack.thuraya.com

The software will show you the latest reported location of all your vessels
which are active, suspended or deactivated on a map. Thuraya SatTrack
will also allow you to view trails for different durations, receive alerts
when the vessel enters a certain area, download tracking history for
vessels, view areas assigned to the vessel, view the weather information
at the vessel location, view different types of maps and overlays and
many other capabilities.

2. Setup

Thuraya SatTrack is automatically associated with one or more Thuraya
SIMs at the time of purchase.

A software account will be set up for you and will provide you access to
all your vessels.

THURAYA Powered by x\ frontM
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2.1 Pre-requisites for End User portal access

RN =

~N o

SatTrack portal access

Steady internet access

Laptop/PC with latest web-browser

Ensure no firewall blocking https://sattrack.thuraya.com/

License key to create the Enduser account to access the Sattrack
Portal

. Active sim-card subscribed to SatTrack portal

Sim-card tray to be used which is provided in the MarineStar
packaging [Thuraya Nano-sim fixed on the tray]

Terminal powered by a reliable power supply with specs: 24V/1.8A
or 12V/3.6A

Clear line of sight with signal strength showing min. 4 bars and
GPS location acquisition until the entire setup is completed without
any interruptions [Refer to Thuraya MarineStar user manual]

10. Test call and SMS prior as a recommendation
2.2 Initial Setup
Access admin Perform Factory Setup wizard
mode default
» Security -> = Security -> » Wizard setting
Administrator Factory reset -> 1,Time >OK->
function-> OK -> OK -> Password DATE->OK->Auto
Administrator — 0000 -> Reset update ->ON -
mode->0OK->0ON- “YES"->OK. The >0OK-> Next ->
>0K->Password terminal will Select correct
— 00000000 -> restart -> OK. timezone of
OK->Back terminal location
(GMT +/-) ->
OK->BACK
S J
g,
< /
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2.3 Link MarineStar to SatTrack

Access admin mode

Program the config

server

+ Security -> Administrator
function -> OK ->
Administrator mode -> OK
-> ON -> OK -> Password —
00000000 -> OK -> Back

* Location -> Settings ->
Config server — input

number “1002" -> Save ->
Back

2.4 Program default tracking values for SatTrack
compatibility

Input tracking Q Input tracking 3 Input tracking - Enable and Save
by Distance by Speed by Time Tracking info
* Location « Speed-> input * Time -> input * -> Check
->Tracking->Tra values: values: “10 days”, distance, speed
cking by “Upper speed “00 hours”, “00 and time tracking
Distance -> OK —> 200km/hr”, minutes” -> types -> Options ->
-> input values “Lower limit — Options -> SAVE SAVE (Very
for Tracking Okm/hr”, Time important) O
Distance: interval: “10 Press END button
“999.99 km” -> days”, “00 on the Marinestar
Time interval: hours”, “00
“10 days”, “00 minutes” ->
hours”, “00 SAVE ->
minutes” -> Move down to
SAVE -> Move configure
down to TIME
configure
SPEED
— ~— \. J/ _ Y,

2.5 Start tracking

Admin mode disable

Start tracking

» Long press the CONTACTS
button. Popup of “Tracking
activated” & arrow blinking is
shown. The terminal is now
fully programmed.

« Security -> Administrator
function -> OK ->
Administrator mode -> OK ->
OFF -> OK -> Back.

THURAYA Powered by }. frontM
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2.6 SatTrack initial setup

Creating an account

- Logon to
https://sattrack.thuraya
.com/

- In the create account
section, enter Full
name, email)should be
unigue for every
license key), enter
password and enter
license key provided
by your Thuraya
service provider.

- Click create account
-> the OTP shall be
sent to the email ID
registered.

- Input the OTP in the
portal wizard (Your
account is now

\created} /

Recommended setup

- In All Vessels left
pane, select the
vessel & select
vessel information in
the hamburger
menu.

- Go to Configuration
-> Alert Types

- Switch ON the
power cycle -> Send
to Terminal.

- You can continue
programming the
other details like
vessel details,
tracking options etc.

Check for link completion

- Open notification
assistant to see the
transactions

- In All Vessels left
pane, select the
vessel & select
vessel information in
the hamburger menu.
- Go to Tracking and
monitoring (You
should see tracking
reports recorded).

- You can now track
monitor and program
required functionality
on the respective
online MSISDN -
MarineStar terminal

Thuraya SatTrack

Welcome!
Log in to Thuraya SatTrack

Email

bhavya+thuraya@frontm.c:

Password

Forgot Password ?

powered b x'\. frontM

Welcome to a more
connected world

Important notes:

1. Ensure you follow all the steps mentioned as pre-requisites in
Section 2.1 of the End user manual.
2. Ensure you do not change the default remote server authentication
pin (00000000) on the terminal

THURAYA
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3. GNSS co-ordinate format DD.ddddd is the only format supported
on the portal. Ensure that the terminal is set up to send location in
this format.

4. The portal is set up for English language.

5. The time shown in the assistant ke
zone on the end users PC).

6. The incoming, outgoing and missed calls are in the time zone that
the terminal was in at the time of making the calls.

7. All other times are in GMT (indicated with a “GMT” tag in the

column header)

is the local PC time (the time

2.7 Deactivation of SatTrack service

1. Request the admin password with your authorized service provider
before deactivating the SatTrack service. Ensure the service and
terminal is online while performing this activity.

2. Use the admin password to Factory reset the terminal.

3. Proceed with sattrack service deactivation with your service provider.
4. The deactivated MSISDN will be available on the portal for one(1)
month from the date of deactivation.

5. The data of the deactivated MSISDN (transactional data and
configuration) will be available upon request for one(1) year from the
date of deactivation.

THURAYA Powered by 3». frontM
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2.8 Understanding the user roles

End
Customer

Level 1 Level 2 Level 3

2.9 Login and User Accounts

You will be able to create an account on the Thuraya SatTrack portal
using the license key provided by Thuraya.

This will allow you to log in to the Thuraya SatTrack portal using the
username (which will be an email ID) and the password chosen by you.

a Thuraya SatTrack

Welcome to a more

Welcomel! connected world
Log in to Thuraya SatTrack

powered b *. frontM
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2.10 SMS usage

The Thuraya SatTrack software communicates with the terminal
usingThuraya track and monitor plans.

The following types of messages will normally be deducted from your
Thuraya track and monitor plans:

1. Responses sent by the terminal to the Thuraya SatTrack portal
eg: Reporting of tracking information, alerts, success/fail
acknowledgment from the terminal for the configuration from the
portal, etc

3. Vessels - view and configuration

3.1 List of Vessels

The Vessel list shows the vessels that the end user logged in has access
to. Vessels are displayed in two views — Map view and table.

All Vessels
All Vessels view: | [I]
O =
O Camara derie
D Jess Phillipines
D Jess Luxury Liner
D VN owl
8

3.1.1 Vessel List — Map View

In the left pane of the Map View, when we click on the Vessel name, a
pop up displays Vessel Name, Last known location & time, Course (in
deg), Last reported SOS location & time, MSISDN, Status, IMEI,
Firmware, Last event, Fleet, IMO, Registration number, Vessel Type
details for each of the vessels.

THURAYA Powered by 3\ frontM
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Vessel Icons Colors and Status

D Unresponsive

D Good Vessel

[  Bad Vessel

D SOS

[ Deactivated

> Suspended

1. Unresponsive vessel - within the last 24 hours/ 1 day; if tracking is

not getting reported by the terminal on 100% of instances; then can
be considered as a unresponsive vessel

2. Good Vessel - within last 24 hours/ 1 day; if tracking is (i) on time
and (ii) without any errors on 75%+ instances; then can be
considered as a good vessel

3. Bad Vessel - within last 24 hours/ 1 day; if tracking is (i) not on time
and (ii) having errors in 25%+ instances; then can be considered as
a bad vessel

4. SOS: If vessel has sent SOS alert within last "4" hours; this vessel
to qualify for SOS type

5. Deactivated - All the deactivated msisdns will have this vessel icon.

6. Suspended - All the suspended msisdns will have this vessel icon.

= .« Thuraya Sattrack UAT (

All Vessels view: [}

[]  Prncess! -

Location: GPS unavailable

- : ) v =
e 5‘? | PEVERELUS roo = |
0%0piF 00|
WOOD Vessel Name Princess |

Last known location GPS unavailable
Course (in deg) 90.0000
Last location time (in GMT) May 29, 2023 6:36 AM
BOYATT \ Last reported SOS location 5°1517°N15°17'11E
2 W00D.
Last reported SOS time (in GMT) Apr 16,2023 4:13 PM

1D Number

1111a

THURAYA' Powered by f\. fontM
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3.1.2 Vessel List — Table

Click on the table view button ( ) to view vessel details in a table
format - Vessel Name, Last known location & time, Course (in deg), ID
Number, MSISDN, Status, IMEI, ADU S/N, BDU S/N, Firmware, Last
event, Fleet, Region, IMO, Registration number, Vessel Type details for
each of the vessels are displayed.

All Vessels View:

D Vessel Name Last Known Location Course (In Deg) Last Location Time (In GMT) ID Number MSISDN Status IMEI ADU S/N BDU S/N

1°16'28"N 103° 882162299 202302230
C: d NA Feb 23,2023 8:14 AM ACTIVE
O amaradene  yggrg i 8785 725472

Jess 25°19'36°N 55° 882162299 358876107
N NA May 20,2023 6:18 PM ACTIVE
O Phillipines 2228°E d 8783 492424

Jess Luxury 25° 14'36°N 55° 882162299 358876104
O e BT 137.8705 May 29,2023 6:28 AM e ACTIVE et

1
25" 1435°N 55° 882162290 358876104 @
D VN Oowl 1045°E 180.9965 May 29, 2023 6:39 AM 1VID 5010 ACTIVE 219945 '

Additionally, Vessel name, Registration number, IMO, Vessel Type, ADU
S/N, BDU S/N and ID Number can also be configured from the Thuraya
SatTrack portal. Please refer 3.2.1 Vessel Details section on how to
configure these.

Selecting a checkbox next to any (one or more than one) vessel will

bring up the menu Icon at the top of the table which in turn will
have Vessel Information & Alert Event History options which allows you
to navigate to the Vessel information and Alert events history tabs
respectively.

= = a

Vessel Information

Alert event history

THURAYA Powered by 3». frontM
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3.1.3 Viewing vessels on the Map

To find a vessel on the map and zoom in on it, you can follow the below
steps:

Step 1: Expand the list of All Vessels. This opens the left pane which
displays all the vessels associated with the End User.

All Vessels 7

O =

VID1111

O

Mamoun
O

EX

Step 2: Click on any of the vessels. The vessel location will be visible on
the map.

Step 3: Click the vessel icon on the map, vessel details are
displayed in a pop up on the map.

3.1.4 Filter and search

We can also filter the Vessels by Vessel Name, Vessel Status, Vessel
Type, Vessel MSISDN, Last Reported Event, Last Reported Event

Sub-Type, Vessel Behaviour, Fleet and Region using the filter
button.

THURAYA Powered by E\ frontM
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Filtering of Vessels:

We can create our own filters by entering the Vessel Name, Vessel
Status, Vessel Type, Vessel MSISDN, Last Reported Event, Last
Reported Event Sub-Type, Vessel Behaviour, Fleet and Region details

Create new filter

Vessel name

Vessel Status

Vessel Type

Vessel MSISDN

Last Reported Event

Last Reported Event Sub-Type

Vessel Behaviour

Fleet

Region

+ Save as new filter

+/ SAVE AND APPLY FILTER

Search Vessels:

We can search vessels by entering the Vessel Name, Vessel Status,
Vessel Type, Vessel MSISDN, Fleet and Region details.

O =

O Chris Terminal-Phase 1

MILEERS!
. DALE{SOUTH

BOYATT
& WO00D,
e,

THURAYA' Powered by f\. fontM
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3.2 Vessel Information

This includes the options below. These are described in more detail in
the following sections.

Please refer to the 3.1 List of Vessels on how to navigate to the Vessel
Information tab.

Important note:
Any configuration changes sent from the Thuraya SatTrack portal will
overwrite the existing settings on the terminal.

To get an overview of the configurations available to the end user, please
refer to the 14. Permissions.

Tips:
1. For every configuration setting sent to the terminal from the portal,
the acknowledgement received from the terminal will be shown in

the assistant at the bottom right corner of the map.

2. The assistant can be opened and the notifications can be viewed

by clicking on the at the bottom right corner of the map area.
3. Before sending any new configuration setting, make sure that the
acknowledgement for the previous setting was received.

THURAYA Powered by x\ frontM
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3.2.1 Vessel Details

This function enables you to view and update Vessel image, Vessel
name, Vessel ID, MSISDN, Subscription Status, Last Known Location &
Time, IMEI, IMO, Registration Number, Fishing License, Length, Vessel
Type, Fleet, Region, Contract ID, and profile.

N\ Vessel

§ CHANGE PHOTO -

Upload an image close to a 4:3 aspect ratio for optimal viewing

SAVE VESSEL IMA

/N Vessel details

eeeeee 11D Vessel name
1111a Princess |
10 cf

ISISDN Subscription Status

8821622990398 ACTIVE

Last Known Location (DD.dddd Last Location Time (GMT

50° 59'10"N 1° 21'58"W 29/05/2023 07:00:45
IMEI IMO numb
358876107404759 IM012345678
MEI should be 15 digit max 18 cha
Registration numbej essel Type
RN 12345678 Bulk carrier -
Fishing license Length
FL 12345678 900

ax 24 chars in meters(Max: 999)
fleet 1 -
Contract | Profile
658724 NewTestProfileal

SAVE

THURAVA. Powered by $. fro ntM
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Captain Details
This section includes details about the captain such as Captain Name,
Captain Mobile Number, Captain Email Address.

/\ Captain details

CN OWL1 +8821622990045

Captain_America@gmail.com

Boat Owner Details
This section includes details about the Boat Owner such as Boat Owner
Name, Boat Owner Mobile Number, Boat Owner Email Address.

/\ Boat owner details

BON_Jess 009719999

Boat Owner Email Address
jess@thuraya.com

Hardware and Firmware Details
This section includes details about the Hardware such as ADU S/N, BDU
S/N, Firmware and Reason (Reason to change the ADU/BDU/IMEI/FW).

/N Hardware and firmware

ADU S/N BDU S/N
3452617889 "2341 56722

ADU S/N should be 12 chars BDU S/N should be 12 chars

Reason
MNB_1.2_S1_TH Faulty ltem v

Reason to change the ADU/BDU/IMEI/FW

SAVE

THURAYA Powered by 3\‘ frontM
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3.2.2 Tracking

Clicking the ‘Tracking and Monitoring’ tab opens the Tracking &
Monitoring map view with trails visible on the map.

3.2.2.1 Tracking Map & Table View

Tracking History will display the history of the points in time the vessel
has been tracked and the locations of the vessel at that time. It will also
display the type of tracking event received (polled, tracking by time,
tracking by speed, tracking by distance), Alert events, GeoFence, SOS,
Course(in deg) which is the difference between the location in the tracks.

Note: Weather information is sourced from World weather online. There
might be some differences with weather forecast from local agencies

Vessel Icon colors and event types

Tracking

SOS

Power Cycle
Reset

Signal Strength

GPS Antenna

URNVAN BN BRVAN

GPIO1&2

Tracking and Monitoring view:  [II Export

® May 25, 2023 12:56 PM

. Date Time (Local Time) May 25, 2023 4:56 PM
May 26, 2023 6:24 AM
Description: N25.24350 E55.82932 Date Time (GMT) May 25, 2023 12:56 PM
GPS N27.24354 E59.82930
May 26, 2023 6:21 AM g Course (in deg) 2417573 deg
ay 26, 2 8
Description: N25.24350 E55.82932 Event Tracking
Event type by time
Speed (km/h) 80
May 25, 2023 12:56 PM -
Description: N27.24354 E59.82930 Area Name N/A
In/Out N/A
= title May 25, 2023 12:56 PM
May 25, 2023 12:55 PM

Description: N30.24354 E58.82930

Summary Partly cloudy

Temperature (C) 30 v

THURAYA Powered by ﬁ. frontM
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Tracking and Monitoring View Export

Date Time (Local Time) Date Time (GMT) GPS Course (In Deg) Event Event Type Speed (Knots) Area Name In/Out Message Reason For Power

Aug 9, 2023 N25.24347

Aug 9, 2023 11:40 AM 11:40 AM £55.82030

173.5494 deg Tracking by time 0 N/A N/A

Aug 9, 2023 N25.24355

Aug 9, 2023 10:40 AM 10:40 AM £55.82020

173.5494 deg Tracking by time 0 N/A N/A

Aug 9, 2023 N25.24352

0:40 AM £55.82026 42.1294 deg Tracking by time 0 N/A N/A .

Aug 9, 2023 N25.24355 .
8:40 AM £55.82024 148.9099 deg Tracking by time 0 N/A N/A

Aug 9, 2023 9:40 AM

Aug 9, 2023 8:40 AM

The refresh button ( the button on the top right of the table with a circular
arrow icon) can be used in case you would like to manually check for
any new messages that might have arrived from the terminal.

Export

This tracking history can be exported to a csv format using the
button. We can also filter the tracking history by duration, Event and

Event type using the filter ___| button.

Exporting the tracking data into a csv file:

Step 1: Click on the “Export” button.

Step 2: The file will be downloaded to your computer. It will be available
in the “Downloads” folder in your computer.

Tip:
1. If you are opening the downloaded csv file in excel, ensure that
you are setting the format of the “MSISDN” column to text. This will
ensure that the MSISDN shows up correctly.

2. To display UTF-8 compliant CSV files when they contain
non-English characters correctly, please follow below steps:
a. open the CSV file using Notepad.
b. Click "File > Save As".
c. In the dialog window that appears - select "ANSI" from the
"Encoding" field. Then click "Save".

THURAYA Powered by z\ FI'OHTM
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d. Open this new CSV file using Excel. Non-English characters will
now appear correctly in the file.

Filtering of Tracking Data:

The Filter allows you to select the duration of the tracking trail that you
want to display on the map/table for a vessel. Default filters available are
Last Day, Last 7 Days, Last 30 Days, Last 60 Days.

Filter Name X

Last day
Last 7 days
Last 30 days

Last 60 days

We can also create our own filters by selecting the duration, Event,
Event Type.

Create new filter

Tracking data

Date - Start (Local Time)

01-01-2023 12:28

Date - End (Local Time)

12-01-2023 12:28

Event

Tracking

Event Type
By time

v Save as new filter

+ SAVE AND APPLY FILTER

THURAYA' Powered by i‘o fontM
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3.2.3 Configuration

Important Note: As an End User, you will be able to view & update all
the configurations except for captain password.

3.2.3.1 Vessel Information

Important Note: As an End User, you will only be able to update the
Vessel Information.

This function enables you to view & update Vessel name, IMO,
Registration Number, Fishing License, Vessel Type, Details to be Sent to
Terminal, Captain Name, Captain Mobile Number, Boat Owner Name,
and Boat Owner Mobile Number.

Users can also retrieve vessel details from the terminal.

\ Vessel Information

‘essel Name IMO Number

VN owl 777

max 24 chars

max 24 chars max 18 chars
jon Number Vessel Type
Bulk carrier -

max 24 chars

Fishing license

FL777

4 char:

Details To Be Sent To Terminal
Boat Owner Details -
Captain name Captain mobile numbe
CN OWL1 +8821622990045
max 24 chars max 24 chars
Boat owner name Boat owner mobile numbef
GREATDRAGON1 +9715076843578

max 24 chars

RETRIEVE FROM TERMINAL SEND TO TERMINAL

3.2.3.2 Tracking

Important Note: As an End User, you will only be able to view/update

the settings in the tracking section.

THURAYA
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There are three types of tracking available — by time, distance, and
speed. The Tracking section enables you to set up any combination of
these tracking parameters.

N\ Tracking

Tracking by tirr
45

Trackir
45

Tracking by distance - interval *
45

Tracking by distance - distance
83

SEND TO TERMINAL

Possible values:

Time Allows you to change the tracking interval, which can be
interval from 3 mins to 14400 min (10 days)
Distance | This tracks the vessel’'s progress over a certain distance —
which can be from 0 — 999 km
This option has 2 parameters that can be configured:
1. Tracking by distance - interval
This defines the intervals at which the terminal will
check the distance travelled.
2. Tracking by distance - distance
This defines the distance to be covered before
sending out the next location tracking message.
Speed This allows you to input an upper and lower speed limit.
1. Tracking by speed - interval
This defines the intervals at which the terminal will
check the speed.
2. Lower speed limit can be between 0 and 99 km/h
3. Upper speed limit can be between the lower speed
limit and 999 km/h
This option, once set, will trigger a notification from the
terminal whenever the vessel speed falls below the lower
limit or breaches the upper limit.
THURAYA
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3.2.3.3 Alert Types

The terminal can be configured to send alerts notifying you of changes to
the terminal environment, like the signal strength going from 0 to 1, the
terminal being reset, Power Cycle, GPS Antenna connection, GPI1O1

and GPIO2 changes.

The Alert Type section allows you to view the current configuration and
also enable/disable the events for which the terminal should send alert
events.

You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.

You can also click on “Retrieve from terminal” to retrieve the
configuration from the terminal.

RETRIEVE FROM TERMINAL ~ SEND TO TERMINAL

THURAYA Powered by 3». frontM
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3.2.3.4 SOS Settings

This allows you to to view the current configuration and also configure
the SOS recipients and messages on the terminal.

You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.

/\ SOS Settings
1002 ;;45T67;§90W
;;45675901 En;égw e
;372456;78901 ém‘s‘W 2

3245678901 60

3.2.3.5 Fish Types

Important Note: As an End User, you will be able to view/update the
fish types configured onto the terminal. You will also be able to retrieve
the catch reports from the terminal.

The Fish types section allows you to view the current configuration and
also configure the fish types your vessel can fish and report.

You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.
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You can also click on “Retrieve from terminal”’ to retrieve the
configuration from the terminal.

/\ Fish types
3 3
3 3

3 3

RETRIEVE FROM TERMINAL SEND TO TERMINAL

r_

3.2.3.6 Fishing Gear

Important Note: As an End User, you will be able to view/update the
fishing gear configured onto the terminal. You will also be able to
manually retrieve the fishing gear information from the terminal.

The Fishing gear tab can be used to view the current configuration and
also configure the fishing gear your vessel carries.

You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.

You can also click on “Retrieve from terminal” to retrieve the
configuration from the terminal.

/\ Fishing gear
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3.2.3.7 GPIO Control & Function

Important Note: As a Thuraya End User, you will be able to view/update
the GPIO settings.

The GPIO Control & Function section is for third-party devices which
may be connected to your Thuraya terminal.

The exact function of the switches will depend on how your system is set
up — speak to your Thuraya Service Partner to learn more

GPIO3 and GPIO4 can be remotely switched from the Thuraya SatTrack
software — changing this will affect the relay switch.

By default, GPIO 1 switch is an SOS alarm and GPIO3 sets off a buzzer
on the terminal. These defaults can be switched to another function
using the dropdown

By default, the GPIO4 switch performs no action — unless your Thuraya
End User has configured it to connect to something.

You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.

You can also click on “Retrieve from terminal” to retrieve the
configuration from the terminal.

/N GPIO control

® crPi03 ® crio4

GPIO3 text GPIO4 text
45_103 45_104

SEND TO TERMINAL

/N GPIO function

GPIO1 Function GPIO3 Function
General - Buzzer

GPIO1 text GPIO3 text
45_1017function 4545GPI03function

RETRIEVE FROM TERMINAL SEND TO TERMINAL

A
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3.2.3.8 Captain Password

Important Note: As an End User, you will be able to only view the
Captain Password. You will not be able to make any modifications to the
Captain Password.

3.2.3.9 Request for Admin Password Change

End User can only request to change the admin password by entering
the reason for changing the admin passwords. The request can be
Approved/ Rejected by the users Customer profile
users/Reseller/SP/Customer Care.

/\ Request for Admin password change

Reason For Change *
Please change the admin password

Reason for requesting Admin password change

SEND FOR APPROV

3.2.3.9 Report Server Settings

Important Note: As an End User, you will be able to view/update the
Report Server Settings.

The Reporting Server settings tab can be used to view the current
configuration and also configure the reporting server and recipients for

your terminal.
You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.

/N Reporting server

e Recipient 2
1002 bhavya@gmail.com
email (max 40 chars) or phone (max 32 digits)
ecipient 3 Recipient 4
rhea_d@yahoo.com 6543456787
email (max 40 chars) or phone (max 32 digits; email (max 40 chars) or phone (ma
Recipient 5 Server
9876565432 1002

email (max 40 chars) or phone (max 32 digits; max 32 chars

SEND TO TERMINAL

[~
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3.2.4 Fish Catch Reports

Important Note: As an End User, you will only be able to view the catch
reports sent from the terminal. You will also be able to manually retrieve
the catch reports from the terminal.

The Catch Reports tab shows the catch reports submitted by the
terminal. It displays the time the report was submitted, the fish type and
the catch weight if entered by the terminal (normally entered in
kilograms)

There are two kinds of fish catch reports.
1. Reports retrieved from the terminal by the end user:
These reports show up with the Source as “polled”
2. Reports sent from the terminal (as a push from the terminal)
These reports show up with the Source as “terminal”

Reports automatically refresh in this table when a fish catch report is
received from the terminal.

Fish Catch Reports

= EXPORT ¢]

Date & Time (Local Time) Date & Time (GMT) Source GPS Speed (Knots) Fish Type 1 Fish Weight 1 (Kg) Fish Type 2 Fish Weight 2 (Kg) Fish Type 3 Fish \

Jul 3,2023 6:17 25°14'36°N LuxuryProfil
Terminal 0

:1
Jul 3,2023 10:17 AM i 55° 40'45°E eFish

5 Tilapia 14 Seabus 9

Jun 21,2023 7:56 Polled 25°14'36°N 0 LuxuryProfil

Jun 21,2023 11:56 AM AM 55° 40'45'E eFish

17 Tilapia 25 Seabus 32

Jun 21,2023 11:42 AM S, AP 728 Polled YN - 4 LuxuryProfil

AM 55° 49'45'E e Fish Lz i & T B2

Jun 21,2023 7:41 25°14'36"'N LuxuryProfil
Terminal 0

AM 55° 49'45°E e Fish 14 Adt 1 Jam 7

Jun 21,2023 11:41 AM

_ Jun 20,2023 8:41 25° 14'36'N LuxuryProfil @
Jun 20, 2023 12:41 PM AM Polled 55° 40US'E 0 e Fish 14 Unknown 13 Unknown ‘

The refresh button ( the button on the top right of the table with a circular
arrow icon) can be used in case you would like to manually check for
any new messages that might have arrived from the terminal.
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Clicking on the Export button will export the fish catch reports and
download it onto the user's PC.

Tip:

1. If you are opening the downloaded csv file in excel, ensure that

you are setting the format of the “MSISDN” column to text. This will
ensure that the MSISDN shows up correctly.

. To display UTF-8 compliant CSV files when they contain

non-English characters correctly, please follow below steps:

a. open the CSV file using Notepad.

b. Click "File > Save As".

c. In the dialog window that appears - select "ANSI" from the
"Encoding" field. Then click "Save".

d. Open this new CSV file using Excel. Non-English characters will
now appear correctly in the file.

Clicking on the Filter button next to the “Export” button allows the
user to filter the Fish catch report data using parameters such as
date and time.

3.2.5 Messages

Important Note: As an End User, you will be able to see the history of

messages sent from the portal to the terminal. You will also be able to

send any messages to the terminal.

Thuraya SatTrack has a message interface to send messages to and

receive messages from Thuraya terminals.

Messages can be used to send the crew weather, emergency, news and

information updates.
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The Messages tab shows a history of all the messages sent from the

portal to the terminal.

Messages

Q x = C

Date And Time (Local Time) Date And Time (GMT) Direction Message Type Message

Aug 4, 2023 4:13 AM Aug 4,2023 4:13 AM received Text Adj

Jul 31,2023 9:12 AM Jul 31,2023 9:12 AM received Text Mwmw

Jul 25,2023 6:03 AM Jul 25,2023 6:03 AM sent Text CNFI10001;00000000;0;00000000;00000000;00000000;

Jul 25,2023 5:25 AM Jul 25,2023 5:25 AM sent Text CNFD90001;00000000;2;1;200N17.86843E083.12291;201N17.40252E083.16136;202N17.76384E083.56236;

Jul 17,2023 12:19 PM Jul 17,2023 12:19 PM sent Text CNFF70001;00000000;0;1;5;1;30;277.80;0;1;30;0;185;

Jul 17,2023 12:17 PM Jul 17,2023 12:17 PM sent Text CNFF70001;00000000;0;1;5;1;30;277.8,0;;1;30;0;185;

o

P Jul 11,2023 3:15 AM Jul 11,2023 3:15 AM sent Text test123 .

The refresh button ( the button on the top right of the table with a circular

arrow icon) can be used in case you would like to manually check for

any new messages that might have arrived from the terminal.

Messages can be filtered by duration, Message Direction and Message

type.

Create new filter

Sent Messages

Message From Date

01-01-2023 16:13

Message To Date
12-01-2023 16:13

Message Direction”
sent

Message Type”
All messages

+/ Save as new filter
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3.2.6 Call Logs

Important Note: As an End User, you will be able to see the data. You
will also be able to retrieve the data from the terminal.

Click on the ‘Calls Logs’ tab to view the call history of the MarineStar
terminal on board a particular vessel. Outgoing calls made from the
terminal, Incoming calls received by the terminal and Calls missed by the
terminal are displayed here.

Clickonthe = ~ icon and select Retrieve incoming calls/ Retrieve
missed calls/ Retrieve outgoing calls to retrieve the calls from the
terminal.

Call Logs can be filtered by duration and Call type.

Edit filter

Filter Name

Incoming Calls X SAVE

Date - Start (Local Time)

04-05-2021 19:52 [m}

Date - End (Local Time)

19-09-2022 19:52 [m}

Type
Incoming v X

V' Save as new filter

+ SAVE AND APPLY FILTER

3.2.7 Call Manager

3.2.7.1 Crew calling

Important Note: As an End User, you will be able to view the Crew
calling setting (whether it is enabled or disabled). You will also be able to
modify the settings on the portal/terminal.
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The toggle button under Crew Calling allows enabling or disabling the

crew from making calls.

/\ Crew calling

@ cCrew Calling

SEND TO TERMINAL

You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.

3.2.7.2 Speed dial

Important Note: As an End User, you will be able view/update the
speed dial numbers.
1. The first speed dial number (1) is always configured to the voice
message (123). Hence only speed dials 2 - 9 are configurable.
2. Speed dial numbers are limited to a maximum of 32 digits only
(including the leading +)

Tip:
PSTN numbers can be entered with a prefix of 00 before the country
code or a prefix of + before the country code.

/\ Speed dial

Speed dial 2

123 9876545678
Speed dial 3 Speed dial 4
23454231234 9089786756
Speed dial 5 Speed dial 6
Speed dial 7

9876545678 Speed dial 8

Speed dial 9
9089786756

SEND TO TERMINAL RETRIEVE FROM TERMIN
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You can make changes and click on the “Send to terminal” button to
send the changes to the terminal.

3.2.7.3 Whitelist

Important Note: As a Thuraya End User, you will be able to view/update
the Whitelist settings (whether they are enabled or disabled) and
Whitelist numbers.

You can view the current status of whitelist setting and currently
whitelisted numbers as well:

1. enable/disable the whitelist setting

2. Configure/edit the whitelisted numbers.

Clicking on “Send to terminal” will send this setting as well as the
numbers to the terminal for configuration.

/N White List
I Whitelist

White List Number 2
1002 9089786756

White List Number 3 White List Number 4
6060 9876545678
White List Number 5 White List Number 6
23454231234 9089786756

White List Number 7 White List Number 8

1. A maximum of 25 numbers can be whitelisted.

2. The first whitelisted number is 1002, hence users can only
configure 24 numbers on the portal.

3. Whitelist numbers added on the terminal directly cannot be
retrieved by the portal. They will be overwritten by the numbers
added on the portal.

4. Whitelisting a number will allow the terminal to only call (outgoing
calls) and receive calls (incoming calls) from that number.
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The Whitelist section allows you to allow only a restricted list of
numbers to call the terminal or for the terminal to call [whitelist].

In other words, incoming calls to the terminal and outgoing calls from the
terminal are only allowed to this/these number(s).

3.2.7.4 Blacklist

Important Note: As a Thuraya End User, you will be able to view/update
the Blacklist settings (whether they are enabled or disabled) & Blacklist
numbers.

You can view the current status of blacklist setting and currently
blacklisted numbers as well:

1. enable/disable the blacklist setting

2. Configure/edit the blacklisted numbers.

Clicking on “Send to terminal” will send this setting as well as the
numbers to the terminal for configuration.

N\ Black List

I Blacklist

Black List Number 1 Black List Number 2
23454231234 9089786756
Black List Number 3 Black List Number 4
9089786756 9089786756
Black List Number 5 Black List Number 6
23454231234 9089786756

Black List Number 7 Black List Number 8

1. Do not add 1002 as a blacklist number as this will prevent the
terminal from sending any messages to the portal.

2. A maximum of 25 numbers can be blacklisted.

3. Blacklist numbers added on the terminal directly cannot be
retrieved by the portal. They will be overwritten by the numbers
added on the portal.

THURAYA Powered by 3\‘ frontM



L ®
a End User manual Page | 36

4. Blacklisting a number will not allow the terminal to either receive
(incoming calls) or call (outgoing calls) to that number.

The Blacklist tab allows you to block certain numbers from calling the
terminal or the terminal calling the number [blacklist].

In other words, incoming calls to the terminal and outgoing calls from the
terminal are not allowed to this/these number(s).

3.2.8 Portal Tracking Areas

Important Note: As an End User, you will be able to view/add the Portal
Tracking Areas.

Areas can be defined on the map for tracking purposes. Thuraya
SatTrack portal allows a user to add upto 100 tracking areas on the
portal. These are not configured onto the terminal but used on the portal
only for tracking.

Tracking by portal areas is dependent on the location reported by the
terminal. Based on the latest location reported by the terminal, the
SatTrack portal will flag the tracking alert as “portal area” if it is within
one of the configured and enabled portal tracking areas.

These alerts will be visible in the Tracking and Monitoring table and map
view with event type as “portal area”, the name of the area that the
vessel has entered or exited and the current status (“in” the area or “out”
of the area).

Portal Tracking Areas

* Area Name Status Commeni ts/Description

WesternAustralia160123 Enabled western Australia again

Sjh Airport Enabled sharjah airport

D : Southern Madagascar22022023 Enabled .

You can add new portal tracking areas by clicking on “New area” button
and then choosing an area that has been previously created by you
(Please refer to Areas on steps to create a new area)
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The display shows the Portal Tracking areas saved on the portal. This
tab shows all the areas set up as portal tracking areas.

Viewing Portal Tracking areas on map:

Step 1: Go to Tracking and Monitoring Map view.

Step 2: Click on Settings icon 1
Step 3: Select Portal Tracking Areas under Areas. The areas will appear
on the map.

[[] Restricted Areas

Radio Silence
Areas

Portal Tracking
Areas

3.2.9 Radio Silence Areas

Important Note: As an End User, you will only be able to view/add the
Radio silence Areas.

Radio Silence Zones

Number * Area Name Status Comments/Description

1 RS1 Disabled
2 RS2 Disabled
3 WesternAustralia160123 Enabled
4 india Disabled

: 5 Madagascar Enabled

6 3ptAcademicCity170123 Disabled
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Areas can be defined on the map for tracking purposes. For example,
You can configure the areas to stop transmissions from the terminal
when it is entering a radio silence zone. Areas [geofences] saved under
Radio Silence turn off the transmission from the terminal when the
vessel enters this area.

The display shows the Radio Silence areas saved on the MarineStar
terminal. The portal allows up to 10 Radio silence areas with 10
geo-coordinates each to be saved on the terminal. Areas saved to the
terminal are displayed on the radio silence tab. This tab shows all the
areas that are set up as Radio Silence zones on the terminal.

When the terminal enters a Radio silence zone that is enabled, a radio
silence zone report (RS) is sent to the portal. These alerts will be visible
in the Tracking and Monitoring table and map view with event type as
“‘Radio silence”, the name of the area that the vessel has entered or
exited and the current status (“in” the area or “out” of the area)

You can add/edit radio silence areas on the terminal by clicking on the
contextual menu against the slot that you want to configure. Choose the
“Edit” option and then select the area you want to configure from areas
that have been previously created by you (Please refer to Areas on
steps to create a new area).

Clicking on save will send the area configuration to the terminal.

Please refer to the Thuraya MarineStar user manual for more
information.

Viewing Radio Silence areas on map:

Step 1: Go to Tracking and Monitoring Map view.
Step 2: Click on Settings icon 1
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Step 3: Select Radio Silence Areas under Areas. The areas will appear
on the map.

[[] Restricted Areas

. Radio Silence

Areas

Portal Tracking
Areas

3.2.10 Restricted Zones

Important Note: As an End User, you will be able to view/add the
Restricted Zone Areas.

Areas can be defined on the map for tracking purposes. Areas
[geofences] saved under Restricted Zone will sound an alarm on the
terminal when the vessel enters them.

Restricted Zones

Number * Area Name Status Comments/Description
1 Southern Madagascar22022023 Enabled
2 Disabled
3 Disabled

4 Riyadh Enabled

: 5 3ptAcademicCity170123 Enabled Academia
P : 6 Disabled

The display shows the Restricted Zone areas saved on the MarineStar
terminal. The portal allows up to 10 Restricted zone areas with 10
geo-coordinates each to be saved on the terminal. Areas saved to the
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terminal are displayed on the Restricted zones tab. This tab shows all
the areas that are set up as restricted zones on the terminal.

When the terminal enters a Restricted zone that is enabled, a restricted
zone report (RZ) is sent to the portal. These alerts will be visible in the
Tracking and Monitoring table and map view with event type as
“Restricted zone”, the name of the area that the vessel has entered or
exited and the current status (“in” the area or “out” of the area)

You can add/edit restricted zone areas on the terminal by clicking on the
contextual menu against the slot that you want to configure. Choose the
“Edit” option and then select the area you want to configure from areas
that have been previously created by you (Please refer to Areas on
steps to create a new area).

Please refer to the Thuraya MarineStar user manual for more
information.

Viewing Restricted Zone areas on map:

Step 1: Go to Tracking and Monitoring Map view.

Step 2: Click on Settings icon
Step 3: Select Restricted Zone Areas under Areas. The areas will
appear on the map.

SouthKorea  Japan

SR

fghanis!
5 Pakista‘n .
. -

= R T o o y
N - ¥ - North Korea
B -~ v
! veew

Vietnam

Philippines
" ke Restricted Areas
Si_ Banda Aceh
|
mal dlvest'!?j)”Zi D Radio Silence
Areas

Tanzania Portal Tracking
N

Areas
Malawi

ZA RS Madagascar ™ . itius
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4. Map display options

There are two types of map options available - Satellite and Basic vector

Click on the Settings icon at the top right corner of the map.
Select the option “Satellite” for Satellite map and “Vector” for Basic
vector map under Map view. The displayed map will be updated.

Export

=
=

Tracking and Monitoring view: 1]

al
; J
HUNANS

GUIZHOU:

@ Satellite
O Vector

. d Restricted Areas
South'Sudan| : Kulhudhuffushi SrilLanka D

Juba —
w Malaysia y
Maldives ‘

Singapore

[Satellite map]

Tracking and Monitoring view:  [I1] Export
> - Basra : N .
HLairo . Shiraz L PN T T - + & &
> —/ — Kuwait g == HAR.
i Pakistan Nepal- s AP HUNAN
RAy, Jaipur [T /Bhutan " o GUIZHOU
Egypt : Pra Je 7
Yagraj ~ gin. & v
United Arab Karachif -+ Bangladesh GUA
Saudi Arabia Emirates  © 6UJ. M.P. JHA. y
—_— uscat Indi & r o
Jeddah ndia v lo
> Oman CHH. Koliata TY‘ QO satelite
B
- oDI.
Mumbai | MAH.
TEL. Visakhapatnam
_ s . Ya @ Vector
i '2yda
Khatoury Eritrea 53133 Yemen Arabian AP
N 2 ;" a KAR. ay o
Sudan Sea Bengaluru Bengal
Nyala - \ . )
LR Djibouti Adan o ‘
Hargeisa KER.
= J g R
L C Ethiopia - 4 [] Restricted Areas I
an . SouthSudan Kulhudhuffushi Sri Lanka |
Juba \ Somalia P 2
et 1

v

o § 7 Malaysia g
Mogadishu Maldives ‘
° &
P Kisanaani Uaanda Singapore V-~

[Vector map]
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5. Overlays

5.1 FAO

The FAO zones (Food and Agriculture organization defined zones for
fisheries) are available as an overlay on the map.

The FAO Zones are displayed as thin grey lines on the map.
Enabling/Disabling of the FAO Zones overlay:

Step 1: Click on the Settings icon displayed on the map.
Step 2: Select the “FAQ” radio button. It will turn ON the FAO Zones.

All Vessels view:  [II]

5.2 EEZ

An EEZ (exclusive economic zone) is an area of the ocean,
generally extending 200 nautical miles (230 miles) beyond a
nation's territorial sea, within which a coastal nation has jurisdiction
over both living and nonliving resources.

Enabling/Disabling of the EEZ:
Step 1: Click on the Settings icon displayed on the map.
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Step 2: Select the “EEZ” radio button. It will turn ON the EEZ overlay.

All Vessels view:  [I]

5.3 Weather Overlay

Enabling/Disabling of the Weather overlay:

Step 1: Click on the Settings icon displayed on the map.

Step 2: Switch ON the Weather Overlay. It will turn ON the Weather
overlay.

All Vessels view:  [I]]

Colombia

Ecuador:

5.4 Custom Overlay

Important Note: As an End User, you will be able to import and view the
imported Overlays on the All vessels screen.
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Custom overlays can be created by the user with the help geojson file.

Import new overlay

¢® Change GeoJSON file

6. My Information

My Information displays the Role, License Key, Name Email ID details of

the logged in user.

My Information

Service partner

UATChrisSP

Regulator Chris Regulator1
Role Regulator level1
License key 6kz4X6L9Mg
Name Cuatreg
Email ID bhavya+cuatreg@frontm.com
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7. Fleets & Regions

7.1 Fleets

User can create fleets of their vessels for ease of operations.

7.1.1 Fleets List

Step 1: Click on the menu button at the top left corner.
Step 2: Select the Fleets & Regions option from the drop-down menu.

Step 3: Select Fleets.

ttrack UAT
e M

Information

313

Vessels

Fleets &
Regions

B

Fleet Name
Fleets

Regions
Fleet YELLOW

F]  Profiles

FN_Luxury
[ Areas

& Logs

Fleet_1
Regional
Offices

FN_government

& Admin

Description

FLEET YELLOW

Luxury vessels

Fleet_1

Military

ADD NEW FLEET

Profile
PN_LP
PN_LP

testprofile

testprofile ‘

All the fleets that are created by you will be visible under the Fleets

table.

Fleets
ADD NEW FLEET
[:l Fleet Name Description Profile
D : Fleet YELLOW FLEET YELLOW PN_LP
D FN_Luxury Luxury vessels PN_LP
|:| : Fleet_1 Fleet_1 testprofile
b D : FN_government Military testprofile
v 0
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The D checkbox next to each fleet will open the fleet menu which will
allow you to perform functions such as Fleet information and Send OTA.

— i

Fleet Information

Send OTA

The : button next to each fleet will allow you to delete the fleets.

Delete fleet

7.1.2 Adding a new fleet

Clicking on the “Add New Fleet” button at the top of the Fleet list will
allow you to create a new fleet.

A new tab is opened to fill in the details and add fleet.

You can create fleets based on:

1. Vessels

2. Vessel Type

3. Regions

Fleet Information

Fleet Name * Description *

Based On” v

Profile ad Trail Color
Trail Color. #0095F2

CANCEL
p
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7.1.3 Edit a fleet

Select the fleet (by selecting the checkbox next to it in the fleet list), and
the menu with “Fleet Information & “Send OTA” options will be enabled.
Select Fleet Information to edit the fleet.

Fleet Information
Fleet Name * Description *
Fleet 1 Fleet 1

Based On” Vessels
Vessels v

%

VN_HMS_Reseller - 8821622990607

Profile
testprofile - testprofile v X Trail Color

Trail Colorffff] | #0005F2

)
SAVE CANCEL ’

7.1.4 Delete a fleet

Select the Delete fleet option from the " menu. Click on the confirm
button to delete the fleet.

Are you sure you want to delete fleet testfleet?

CANCEL CONFIRM
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7.1.5 Send OTA

Select the fleet (by selecting the checkbox next to it in the fleet list), and
the menu with “Fleet Information & “Send OTA” options will be enabled.
Select Send OTA option to send the OTA commands for the vessels in
the fleet.

Send OTA

Vessels Configuration Call Manager  Radio Silence Zones Restricted Zones

Princess 1- 8821622990398

We can update Tracking, Alert types, SOS settings, Fish Types, Fishing
gear, GPIO control & function, Crew Calling, Speed Dial, Whitelist,
Blacklist, Radio Silence zones and Restricted zones of multiple vessels
at a time using the send OTA feature. Each section will have a “Send to
terminal” button.

7.2 Regions

Users can create regions of their vessels for ease of operations.

7.2.1 Regions List

Step 1: Click on the menu button at the top left corner.
Step 2: Select the Fleets & Regions option from the drop-down menu.
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Step 3: Select Regions.

My ttrack UAT o

Information
8821622990607 - VN_HMS_Reseller Fleets New Fleet Regions

)]

Vessels

Fleets &
Regions

B

CREATE REGION
Fleets

. * Region Name Description
Regions

F]  Profiles RN_TestRN1_LuxuryRegion Area for Luxury vessels

M Areas

Logs

Regional
e Offices

@ Admin

All the regions that are created by you will be visible under the regions
table.

Regions

CREATE REGION

* Region Name Description

RN_TestRN1_LuxuryRegion Area for Luxury vessels

see

The button next to each region will allow you to edit/delete the fleets.

7.2.2 Adding a new region

Clicking on the “Create Region” button at the top of the Region list will
allow you to create a new region.
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A new tab is opened to fill in the details and add region.

Region name *

Vessels

Description

CANCEL

7.2.3 Edit a region

.
.
-

Click on

button next to the region & select “Edit Region” option.

Edit region

Delete region

Update the region details and save.

Region Name *
Region1

Princess | - 8821622990398

SAVE

Description
Region1

CANCEL

THURAYA
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7.2.4 Delete a region

Select the Delete region option from the

8. Profiles

User can create groups of fleets of their vessels for ease of operations.

8.1 Profiles List

Step 1: Click on the menu button at the top left corner.
Step 2: Select the Profiles option from the drop-down menu.

menu delete the region.

® m:ormation
& Vessels
© oo
E]  Profiles
[ Areas
Logs
Regional

© Offces
@ Admin

I M  Help

ttrack UAT

N_HMS_Reseller

ofix

_LP

eSameLP

orofile

Fleets

* Profile Name

PN_LP

PN_LP

testprofile

New Fleet

Created On (GMT)

Tue, 17 Jan 2023 06:56:45

Tue, 17 Jan 2023 07:07:53

Wed, 18 Jan 2023 09:10:47

Regions

Q

Created By

thurayaec

thurayaec

thurayaresellec

New region

Last Edit (GMT)

Fri, 26 May 2023 03:27:09

Wed, 18 Jan 2023 06:50:32

Wed, 18 Jan 2023 09:10:47

Profiles

CREATE NEW PROFILE

Edited By
thurayaec

thurayaresellec

thuraya

All the profiles that are created by you will be visible under the profiles

table.

Profiles

O

I:l

* Prefix

PNP_LP

SameSameLP

testprofile

* Profile Name

PN_LP

PN_LP

testprofile

Created On (GMT)

Tue, 17 Jan 2023 06:56:45

Tue, 17 Jan 2023 07:07:53

Wed, 18 Jan 2023 09:10:47

Q

Created By

thurayaec

thurayaec

thurayaresellec

X =

Last Edit (GMT)

Fri, 26 May 2023 03:27:09

Wed, 18 Jan 2023 06:50:32

Wed, 18 Jan 2023 09:10:47

CREATE NEW PROFILE

Edited By
thurayaec

thurayaresellec

thuraya

Clicking on the profile name will allow you to view the profiles.

THURAYA

Powered by

f\‘ frontM




L ®
a End User manual Page | 52

The D checkbox next to each profile will enable a menu at the top of
the table that will allow the user to copy profiles, download profiles and
delete profiles.

—_— A

Copy profiles
Download profile

Delete profiles

8.2 Create new Profile

Clicking on the “Create New Profile” button at the top of the profile list
will allow you to create a new profile.

Configuration ~ Call Manager ~ Radio Silence Zones  Restri

/\ Details

A new tab is opened to fill in the details which includes Profile prefix,
Profile name, vessel type, Tracking, Alert types, SOS settings, Fish
Types, Fishing gear, GPIO control & function, Crew Calling, Speed Dial,
Whitelist, Blacklist, Radio Silence zones and Restricted zones and then

profile is added.
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User can only save the profile or save and apply the profile.

Save will only save the profile without sending out configuration
commands to the selected vessels.

Save and Apply will save the profile and also send configuration
commands to configure the vessels selected with the profile
configurations.

8.2 Edit Profile

Clicking on the profile name in the profile list will allow you to view/edit
the profiles.

8.3 Delete Profile

Select the D checkbox next to each profile and select delete profiles
from the menu. Click on the proceed button to delete the profile.

Are you sure you want to delete the profiles: PN_LP?

CANCEL PROCEED

8.4 Copy Profile

Select the D checkbox next to each profile and select copy profiles
from the menu. Profile tab opens up with the same data as the profile
selected. User can save it as is or update any data and save the profile.

8.5 Download Profile

Select the O checkbox next to each profile and select Download
profiles will download the profiles in csv file. The file will be downloaded
to your computer. It will be available in the “Downloads” folder in your
computer.
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9. Areas

Important Note: As an End User, you will be able to view/add/update
the areas.

Areas is a menu item in the top-left corner menu. Areas will have a map
view. In the map view, areas are listed in the left pane and their
respective locations are marked on the map when selected.

Create area

Areas

Riyadh

Karachi 10point7de22

NPGW

Batayih

Seyouh

9.1 Creating an Area file for import

The file should be created and saved in csv format — the Area name can
be entered while importing the file.

You can create and edit these in a spreadsheet program Microsoft
Excel, or in a plain-text tool like notepad. The file should have two
columns and up to 100 rows.

The first row should be the header (latitude, longitude).
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Latitude in a decimal
degrees format with
the following prefix:

(i) -to denote S
(ii) no prefix for N
e.g.

3747775
09.56486
-66.43152
-05.65735

Longitude in a decimal
degrees format with
the following prefix:

(i) - to denote W
(i) no prefix for E
eg.

023.88643
126.88161
-033.98412
-003.78432

Each row represents a corner of the boundary of the area to be defined
on the terminal. These should be sequentially ordered, so Point 00 is
joined to point 01, point 01 to point 02 etc.

The last geo point is joined to the first geo point to draw an enclosed

shape.

Important notes:

1. If you open the file in a spreadsheet software like excel, the
leading zeroes will be removed (i.e. it will become
1.54675,23.52134 instead of 01.54675,023.52134), which will
cause the file to error when uploading onto the portal.

You can fix this by either changing the cell to a “text” format in the
spreadsheet or opening the file in a plain text tool to ensure the
leading zeroes are not removed.

2. Only areas with less than or equal to 10 co-ordinates can be
assigned to “Radio Silence" and “Restricted Zones”.

3. Areas with more than 10 co-ordinates can be assigned to
“Portal tracking areas" only.

THURAYA
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4. UTF-8 compliant CSV files when they contain non-English
characters. To display correctly, please follow below steps:

a. open the CSV file using Notepad.
b. Click "File > Save As".

c. In the dialog window that appears - select "ANSI" from the
"Encoding" field. Then click "Save".

d. Open this new CSV file using Excel. Non-English
characters will now appear correctly in the file.

Tips:

1. If the points are not sequentially ordered, it will error out and the
area will not be loaded onto the portal.

2. The latitude should always be 2 digits (02, 25, etc) and the
longitude should always be 3 digits (005, 012, 123, etc) before
the decimal point.

3. If the precision for Latitude/Longitude is less than or more than
5 digits after decimal, it will error out and the area will not be
loaded onto the portal.

Sample file:

latitude,longitude
52.17176,-001.93881
50.60889,-002.01022
50.85228,001.18129
52.31639,001.24721
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9.2 Creating a new area

A new area can be created by

1. importing a csv file and storing it on the portal.

2. drawing an area on the map and storing it on the portal

This area can then be assigned to the respective slots.

9.3 To import a csv file to create a tracking area

Step 1: Click on the “Create Area” button present in the top right.
Step 2: Fill in the name (as you would want it to appear in the list) and
upload the file using the “Upload Your file” button.

Create new area

Name *

Eritrea

"t Pakistan/"

Step 3: Click on “Save” to upload the file and save it on the portal.

THURAYA
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9.4 To draw an area on the map

Step 1: Click on the “Create Area” button on the right top
Step 2: Fill in the name (as you would want it to appear in the list)
Step 3: Click on “Polygon tool” and draw area on the map

i i Py san " _
S

" Saudi Arabia o Bangladesh

o Oman

India
Laos'

~ <

Vietnam
~

SrilLanka . &
ald N i 2 .

G
South Africi

Step 4: Click on “Save” to upload the file and save it on the portal.

! 0 0
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10.Logs

Logs option is available under the Main menu. All the incoming and
outgoing messages are being shown under ‘Logs’.

The information under "Logs" include MSISDN, IMEI, Date and Time,
OTA Type, OTA SubType, Direction, GPS, Speed, Area Name, In/Out
and Message. If values are not available ‘N/A’ is displayed.

Logs
Q X T EXPORT c
MSISDN IMEI Date And Time (Local Time)  Date And Time (GMT)  OTAType OTA Sub Type Direction GPs Speed AreaName  In/out
761042
220916434363 2555/6‘ 421998 sep6,20237:36 AM Sep 6,20233:36 AM Poll Pollfishreport  sent
o 6 761042190, nal par
220916434365 35887610421994 16,2023 6:26 AM Sep 6,2023 2:26 AM FSTina) parsretes H/W or S/W update received N/A N/A N/A N/A
0 5 update
220016434365 3587610421994 N25.24343
s Sep 6,2023 6:26 AM Sep6,20232:26 AM Alert event Power cycle event received Fitn N/A N/A N/A
5 £55.82027

2209 6 761042190 23.243
Z20910434365)  DEOTCIMR9NM o 2023620 AM Sep6,20232:21 AM Tracking Tracking - Time received Nzs2aa24 80Km/h
0 5 £56.82030
220916434365 3588761042194
: : Sep6,2023 6:11 AM Sep6,20232:11 AM Response Tracking configuration received N/A N/A N/A N/A
220016434 35887610421994
covloames :BB Pl Sep 6,2023 6:10 AM Sep6,20232:10 AM Configuration Tracking configuration sent

<] 220016434365 35887610421994
z : Sep 5,2023 1255 PM Sep 5,2023 8:55 AM Poll Poll fish report sent N/A N/A N/A N/A

Export

Logs can be exported to a csv format using the button. We can
also filter the logs by Duration, Message Direction, Message Type,

MSISDN and IMEI using the filter L__| button.

Exporting the Logs into a csv file:

Step 1: Click on the “Export” button.

Step 2: The file will be downloaded to your computer. It will be available
in the “Downloads” folder in your computer.

Tip:
1. If you are opening the downloaded csv file in excel, ensure that
you are setting the format of the “MSISDN” column to text. This will
ensure that the MSISDN shows up correctly.

2. To display UTF-8 compliant CSV files when they contain
non-English characters correctly, please follow below steps:
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a. open the CSV file using Notepad.

b. Click "File > Save As".

c. In the dialog window that appears - select "ANSI" from the
"Encoding" field. Then click "Save".

d. Open this new CSV file using Excel. Non-English characters will
now appear correctly in the file.

Filtering of Logs Data:
We can create our own filters by selecting the Message Direction,
Message Type, MSISDN and IMEI.

Create new filter

Messages From Date
01-01-2023 11:24

Messages To Date
13-01-2023 11:24

Messages Directio
sent

Message Type
POL

MSISDN
8821622990398

IME
358876107404759

+/ Save as new filter

+/ SAVE AND APPLY FILTER
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11. Regional Offices

Important Note: As an End User, you will be able to view/add/update
the Regional Offices.

Regional Offices is a menu item in the top-left corner menu. Regional
Offices will have map view and table view. In the map view, regional
offices are listed in the left pane and their respective locations are
marked on the map. In table view, Regional Office Name, Latitude and
longitude details are displayed.

Regional Offices View:

Rhearegional

regionalof14

regionalof15

regionalof16

Regional Offices View: Create regional offices

Q X

D Regional Office Name Latitude Longitude

O Burj Khalifa 25°11'51'N 55° 1627'E

O Rhearegional 48°40'41'S 122° 40'41°E
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11.1 Creating Regional office file for import

The file should be created and saved in csv format. You can create and
edit these in a spreadsheet program Microsoft Excel, or in a plain-text
tool like notepad. The file should have three columns and up to 100
rows.

The first row should be the header (regionalOfficeName, latitude,
longitude). User can enter any name in the regionalOfficeName column,
latitude and longitude of the regional office in the second and third
column respectively.

Latitude in a decimal | Longitude in a decimal
degrees format with degrees format with the
the following prefix: following prefix:

(i) -to denote S (i) - to denote W

(ii) no prefix for N (ii) no prefix for E

e.g. eg.

3747775 023.88643

09.56486 126.88161

-66.43152 -033.98412

-05.65735 -003.78432

Important notes:

1. If you open the file in a spreadsheet software like excel, the
leading zeroes will be removed (i.e. it will become
1.54675,23.52134 instead of 01.54675,023.52134), which will
cause the file to error when uploading onto the portal. You can
fix this by either changing the cell to a “text” format in the
spreadsheet or opening the file in a plain text tool to ensure the
leading zeroes are not removed.
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2. UTF-8 compliant CSV files when they contain non-English
characters. To display correctly, please follow below steps:

a. open the CSV file using Notepad.
b. Click "File > Save As".

c. In the dialog window that appears - select "ANSI" from the
"Encoding" field. Then click "Save".

d. Open this new CSV file using Excel. Non-English
characters will now appear correctly in the file.

Tips:

1. The latitude should always be 2 digits (02, 25, etc) and the
longitude should always be 3 digits (005, 012, 123, etc) before
the decimal point.

2. If the precision for Latitude/Longitude is less than or more than
5 digits after decimal, it will error out and the area will not be
loaded onto the portal.

Sample file:

regional OfficeName, latitude,longitude
reqgOfcName1,27.67855,-112.67856
regOfcName?2,50.60889,-002.01022
regOfcName3,50.85228,001.18129
regOfcName4,52.31639,001.24721

11.2 Creating a Regional Office

A new Regional Office can be created by importing a csv file and storing
it on the portal.
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11.3 To import a csv file to create a Regional Office
Step 1: upload the Regional Office csv file using the “Upload Your file”

button.

Create regional offices

Step 2: Click on “Save” to upload the file and save it on the portal.

12. Admin

12.1 Admin Settings

Admin settings include report frequency and metrics settings.

12.1.2 Report Frequency

Important Note: As an End User, (based on the permissions provided to

you by the Level 1 user) you will be able to update the Report

Frequency.

Admin settings

Report frequency  Metrics
Report Frequency

lect Al Active MSISDNs

aaaaa

aaaaaa

aaaaaaaaaaaaaaaaa

aaaaaaaaa
Diiomes m e

b 9
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When a vessel enters any of the areas - the value configured as
“Frequency” corresponding to the entered area will be assigned to
“Tracking By Time - Interval” and configured on the terminal.

When the vessel exits the area, the “Tracking by time - Interval” will
revert to the previous value.

12.1.2 Metrics

User can update the metrics configuration in this menu. Below are the
metrics available:

1. Speed - options are “Kilometre/hour” and “Knots”

2. Weight - options are “Kilogram” and “Pounds”

3. Temperature - options are "Celsius" and "Fahrenheit"

4. Distance - options are "Kilometre" and "Miles"

5. Height - options are "Metres" and "Feet"
When the user chooses a metric here and clicks on save, all the values
on the portal will be updated to reflect values in the selected metric.

12.1.3 Notifications

Notifications allows the user to send notifications to the selected user
roles when any SOS comes in.

/\ Email preferences

Email SOS Notifications To End Users (All Levels)
[ Email SOS Notifications To Resellers/Regulators (All Levels)
[ Email SOS Notifications To Service Partners

[J Email SOS Notifications To Customer Care

5

Selecting the users you want to notify and clicking on “Save” will send
notifications to the selected users whenever an SOS comes in from any
of the vessels for this user.
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12.2 Create Users

Important Note: As an End User, you will be able to create users only if
you are a Level 1 user. As a level 2 or level 3 End user, you will not see
this menu.

Create Users is a Sub menu item under the Admin menu in the top-left
corner menu.

= . Thuraya Sattrack UAT (% e

@ My Information sels overview w

& Fleets & Regions v View:

Bl Profiles

[ Areas

& Logs

© Regional Offices

@ Admin ~
Admin Settings
Create users
Permissions
Search Users

A Help v

12.2.1 Add New User

New user

Clicking on this button at the bottom of the Users list will allow
you to create a new level 2 & level 3 user.
A new row is added to the table. Fill in the details into the new row.

v X Level 2 User bhavya@gmail.com - Level 2 x

Click on the + button to save the user.

The newly created user will receive an email with their credentials.
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12.2.2 Edit User

Click on the menu ‘ beside the user created & click edit option.

Edit

Delete User

v X uatl3 bhavya+uatl3@frontm.com Q ~ Level 3 -

User can update primary fleet and Level & Click on the  button to save
the details of the user.

12.2.3 Delete User

Click on the menu  beside the user created & Select Delete User

Edit

Delete User

option.
Click on Confirm to delete the user.

Are you sure you want to delete this user

CANCEL CONFIRM

12.3 User Permissions

Important Note: As an End User, you will be able to access this menu
only if you are a Level 1 user. As a level 2 or level End user, you will not
see this menu.

This allows the End User Level 1 User to provide/revoke permissions to
Level 2 and Level 3 End User Users.
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Select the user type for which you want to view/edit permissions.

User Permissions

User Type

Level 2

Level 3

End user

Select the features to provide access & select the access (Hidden, Read
or Write). Access for the selected user type will be updated.

= -

Permission A

: Vessel Information Read

Tracking Writ

: GPIO controls and functions Read

: Fish types and nets Write

5
a /

- . s v e g G

12.4 Search Users

Search users tab list all the users under your hierarchy. Search Users
include Service Partner, Reseller/Advanced profile users, End Customer,
User Name, User Email ID, Role and license key information of all the
users.
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User can search by License key and Customer Name.

D Service Partner Reseller/Regulator End Customer User Name User Email ID Role License Key
SP - Thuraya Thuraya UAT End Customer - UAT End Customer - Level

D UAT Resallar 1 thurayaec bhavya+thurayaec@frontm.com 1 eQftGZaQ8U

D SP - Thuraya Thuraya UAT End Customer - UAT thurayareselle bhavya+thurayaresellec@frontm.co End Customer - Level QftGZaqsy
UAT Reseller 1 & m 1
SP - Thuraya Thuraya UAT End Customer - UAT 5 s e End Customer - Level

|:| UAT Feaaies 1 Angie angie@jolie.com 5 eQftGZaQ8uU
SP - Thuraya Thuraya UAT End Customer - UAT End Customer - Level

D UAT Reseller ] thurayares|2a bhavya+thurayaresl2a@frontm.com 2 eQftGZaQ8U

D ﬁ:-I:Thuraya ;2::?; dal snd Clslomerstal thurayaresl|3 bhavya+thurayaresI3@frontm.com gnd clhiepte] eQftGZaQ8U

Filtering of Users:
We can create our own filters by filling in SP/Reseller/Regulator/End
customer name, Role, Username, License key details.

Create new filter

ervice Partner

SP/Reseller/Regulator/End Customer Name

Thuray PGW

Role
Service provider

User Name / User Email ID
Thurayatest@test.com

License Key

gshdf734fg

" Save as new filter

+~ SAVE AND APPLY FILTER
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13. Help (on portal)

There is a help menu available on the portal. On clicking the menu at the
top left, a “Help” menu is available. This menu has the following sub
menus:

FAQ’s & Support: Clicking on FAQ’s menu will open a new tab with
following subtabs -

1. Frequently Asked Questions: This tab includes a series of
questions that are commonly asked by customers.
2. Support: Thuraya Customer Care details.

Download End User Manual: Clicking on Download End User Manual
will download this End user manual. The file will be downloaded to your
computer. It will be available in the “Downloads” folder in your computer.

14. Permissions

You will have the permissions to remotely program or retrieve some data
from the terminal (notifications and request for information from the
portal to the terminal, reporting from the terminal to the portal and
configuring the terminal) based on the table below.

You will, however, be able to view all the data even where you do not
have the permission to retrieve or configure it.

For more detailed access levels provided as a default, refer to Standard
profile End User Permissions

Important Note: If you request to change the Captain password, your
request will be routed to the immediate next level for approval.
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